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Guidelines for the Preparation of Dissertations, Theses and Research Papers 

 

SUBMISSION DEADLINES 
Spring  

¶ Initial Submission Deadline - 12th week of the Semester, Friday, 4:30 PM 

¶ Final Submission Deadline - 13th week of the Semester, Friday, 4:30 PM 

For example, for Spring 2021 the deadlines are 

¶ Initial Submission Deadline - April 2, 2021, 4:30 PM 

¶ Final Submission Deadline - April 9, 2021, 4:30 PM 

Summer 

¶ Initial Submission Deadline - 3rd week of the Semester, Friday, 4:30 PM 

¶ Final Submission Deadline - 4th week of the Semester, Friday, 4:30 PM 

For example, for Summer 2021 the deadlines are 

¶ Initial Submission Deadline - June 25, 2021, 4:30 PM 

¶ Final Submission Deadline - July 2, 2021, 4:30 PM 

 

Fall  

¶ Initial Submission Deadline - 12th week of the Semester, Friday, 4:30 PM 

¶ Final Submission Deadline - 13th week of the Semester, Friday, 4:30 PM 

For example, for Fall 2020 the deadlines are 

¶ Initial Submission Deadline - November 6, 2020, 4:30 PM 

¶ Final Submission Deadline - November 13, 2020, 4:30 PM 

 

Important Information : 

¶ Any day before the initial deadline is okay for submission. Upload your paper as soon as 

possible to get the feedback faster. 

¶ Submit a complete paper by the initial deadline. Your submission should include all 

required pages, should not have any blank pages or unfilled charts.  

¶ Revise your paper based on the feedback provided by the administrator and resubmit it. 

This process continues until the paper meets the guidelines and format required. (You pay 

ProQuest when you submit the first time, but you donôt pay for any subsequent 

submissions. There is not a fee for Research Paper submission to OpenSIUC.) 

¶ The initial and final submission deadlines are firm. If you cannot meet both deadlines, 

then your paper will be considered for the following semester graduation. 
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Who must submit final papers to the Graduate School? 

¶ All Ph.D. students must submit Dissertations. 

¶ Some Ed.D. students submit Dissertations; others submit Research Papers. Consult your advisor. 

¶ Some MasterΩǎ ǎǘǳŘŜƴǘǎ ǎǳōƳƛǘ Theses; others submit Research Papers; others do not submit a 
final paper to the Graduate School. Consult your advisor. 
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PART I ï THESIS/ DISSERTATION GUIDELINES  
 

ORGANIZATION OF PAGES  

Download and use a template for your paper! Here is the link: Thesis/Dissertation Templates 

The pages of your paper should be in the following order: 

1. Title page 

2. Copyright statement (when applicable) 

3. Approval page 

4. Abstract 

5. Dedication (Optional) 

6. Acknowledgments (Optional) 

7. Preface (Optional) 

8. Table of Contents 

9. List of Tables (with page references ï required if you have more than one table) 

10. List of Figures (with page references ï required if you have more than one figure) 

11. Text/Body 

12. Exhibits (tables, figures, photographs, etc. ï only required if you are presenting all of 

your tables and figures after the body of your paper) 

13. References (or other appropriate title prescribed by your programôs style manual) 

14. Appendices (Optional ï required if you have copyright permission or other documents 

that do not fit elsewhere in your paper) 

15. Vita  

TITLE PAGE 

¶ Make sure that your paper title on the title page, the approval page, the abstract page, the 

vita page, and your Oral Defense and Thesis/Dissertation Approval forms match exactly. 

¶ Month Year at the bottom of this page is the month and year of graduation. 

APPROVAL PAGE 

¶ Only the names (not the signatures) of your committee are needed for this page. (The 

signatures will be on the original Thesis/Dissertation Approval form that is submitted to 

the Graduate School.). Do not include a committee memberôs name on this page if that 

member didnôt sign both your approval form and your oral defense form. 

¶ Use your official SIU major in the line ñin the field of é." 

¶ Date on this page is the date on which your committee signs your approval form. It 

should be in the format Month Date, Year, for example, March 8, 2019. 

https://gradschool.siu.edu/current-students/thesis-dissertation-researchpaper/etd-templates.php
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ABSTRACT 

¶ Date on this page is the date of your defense in the format Month Date, Year. 

TABLE OF CONTENTS 

¶ Do not list the Table of Contents as an entry on the Table of Contents page. 

¶ Put the ones digit of every page number in a straight vertical line at the right margin. 

¶ Include the titles of Chapters and Appendices. 

o For Thesis / Dissertation - headings within chapters may also be included, but this 

is optional. 

¶ Where chapter titles are longer than one line, end the first line before it reaches the page 

number vertical line, and then indent the first word of the second line so that it starts 

under the first word of the title. (See templates.) 

¶ Indent the chapter listings under the word CHAPTERS, and indent the appendices 

listings under the word APPENDICES.  

¶ The APPENDICES line is only required if you have more than one appendix. If you have 

only one appendix, then name it APPENDIX. If you have more than one appendix, then 

name them with capital letters, for example, APPENDIX A, APPENDIX B, APPENDIX 

C, etc. 

¶ Table of Contents are already created on the templates, and you only need to customize 

this page. Another option is to create an active Table of Contents by following the 

instructions below. 

Inserting a table of contents using the inbuilt option from MS Word 

¶ In Word, tables of contents rely on your use of styles to format headings. If you already 

used the Heading 1, Heading 2, and other heading styles to format your document, youôre 

ready to insert your Table of Contents. Follow these steps to insert a Table of Contents: 

o Click where you want to create the table of contents and click the References tab. 

In the Table of Contents group, click Table of Contents. 
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o Choose the style of Table of Contents you wish to insert. Automatic Table 1 

creates a Table of Contents titled Contents. Automatic Table 2 creates a Table of 

Contents titled Table of Contents. So, Automatic Table 2 is recommended.  

o Manually add the sub titles CHAPTER and PAGE and align them utmost right 

and left respectively. 

o Word will create a Table of Contents from the document text you styled with one 

of the first three heading styles: Heading 1, Heading 2, and Heading 3. The Table 

of Contents will include a string of dots between the heading text and the page 

number for each heading. 

o When readers hover over a page number, the headings are highlighted which 

reminds that they can use the Table of Contents for navigation. 

¶ After the headings are inserted, change the font style of the title TABLE OF 

CONTENTS, center align it, make it all capitals and also set the font color to Black.  

¶ Set the line spacing to 2.0, change the font style, size of the headings, page numbers (if 

needed) to make it consistent with the rest of the document.  

Updating Table of Contents 

After youôve edited your document, page numbers and headings may change, which will make 

your Table of Contents incorrect!  

¶ To update your Table of Contents, right-click in the table and choose Update Field 

or 

¶ choose Update Table from the Table of Contents group on the References tab. Select 

entire table or page numbers only and click OK to regenerate the table of contents from 

your headings. 

 

No Heading styles? 

¶ If the headings in your document arenôt formatted with styles, before inserting your table 

of contents, select each of the top-level headings for your Table of Contents and apply the 

Heading style from the Styles group on the Home tab of the ribbon. 
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or 

¶ Follow the templates and manually type in the headings to create a Table of Contents. 

 

LIST OF TABLES and LIST OF FIGURES 

¶ Put the ones digit of every page number in a straight vertical line at the right margin. 

¶ It is required to include table/figure title next to table/figure number. 

¶ Where table/ figure titles are longer than one line, end the first line before it reaches the 

page number vertical line, and then indent the first word of the second line so that it starts 

under the first word of the first line. 

For exampleé 

Figure 23. The effect of switch cost on the total annual cost and the optimum number of  

                  switches....................................................................................................................... 65 

 

Formatting Guidelines 

FONTS 

¶ Use the same font throughout your paper. Some standard fonts to choose from: Times 

New Roman, Bookman, Courier, or Ariel. 

¶ The regular text in the body of the document should use a 10 or 12 point font size. 

Headings and subheadings may go up to 14 point but must be of the same font style as 

the body of the text. 

¶ Bold and Italics may be used. In general, italics is used for Genera, species, letters, 

words or phrases cited as a linguistic example, and foreign words. Bold and italics may 

be used to distinguish heading and sub-heading levels; follow your department 

guidelines, and be consistent throughout your paper. 

¶ For tables, six (6) point font should be the smallest used. Try to use the same size as the 

rest of the body, if possible. 

SPACING 

¶ The body of the document must be double spaced.  

¶ There should be no extra spacing between paragraphs. 

¶ There should be no extra spacing before and after each sub-heading. 

¶ Spacing within the table may be single or double spaced based on readability. 
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¶ There should be a judicious use of spacing to "set off" tables, charts, and figures; 

typically, one double space before and after the table. Again, once spacing is chosen, you 

must be consistent throughout. 

¶ Places where single spacing is acceptable: 

¶ Between the lines of a title or heading that takes up more than one line. (Note: when 

breaking for second line, do not break up a word. Consider readability.) 

¶ Between the lines of a long quote that is indented on both sides. 

¶ Within a figure or table. 

¶ Between the lines of a figure/table title or explanation/description  

¶ Within a reference in the References section. If you single space between the multiple 

lines of a reference, then you should insert a blank space between reference entries. 

¶ Within footnotes. 

Double spacing the document 

¶ Navigate to Design tab. 

¶ Go to Paragraph Spacing (on Top Right) and Set that to Double. 

 
or 

¶ Select the paragraph which needs to be double spaced. 

¶ Navigate to Home ĄParagraph line spacing options Ą2.0 

Deleting extra space above each sub heading, paragraphs.  

Only 2.0-line space is allowed throughout your work. Sometimes, though the line spacing is set 

to double, you still can see some extra space between the lines, especially above each sub 

heading, new paragraph etc.  

To fix this: 

¶ Select text.  

¶ On Home tab Ą Paragraph Ą Click paragraph Settings button on the bottom right. 
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¶ On Indents and Spacing tab set the Spacing to 0 for both Before and After tabs. 

¶ Click OK. 
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TEXT JUSTIFICATION 

¶ The text in chapters should be left justified only, unless your program requires full 

justification of text (e.g., Mathematics). 

¶ Text on title page and approval page are centered. 

¶ Chapter titles are centered, and other headings may be centered, as fits your program- 

designated style. 

MARGINS AND INDENTATIONS 

¶ Margins are one inch all around. So, text should start one inch below the top of the page 

and end one inch above the bottom of the page.  

¶ Pages with charts, tables, and figures may have greater margins than listed but may not go 

into the required margins. 

¶ Paragraph indentations should be a uniform five spaces.  

¶ With a heading at the bottom of a page, when there is not room for at least one line of 

text under it, move the heading to the next page. In this situation, it is acceptable to have 

a larger bottom margin. 

PAGINATION 

¶ No page numbers on Title page, Copyright page, or Approval page. 
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¶ The pages after the Approval page and preceding the text, i.e. Abstract, 

Acknowledgements, Table of Contents etc. should be numbered using lower case Roman 

numerals (i, ii, iii, ..) starting with Abstract.  

¶ Roman numeral page numbers must be centered and positioned one-half inch from the 

bottom of the page. 

¶ Text pages, References/Bibliography, Appendices and Vita should consist of Arabic 

numerals (1, 2, 3..) only, without punctuation, embellishment, or running headers. This 

numeral paging should be continuous. 

¶ For theses and dissertations, the Arabic page numbers may be located either right-aligned 

on the top of the page or centered one-half inch from the bottom of the page. 

¶ Page numbers need to be consistent with the same font style and size as the regular text. 

¶ If a page of your document is formatted with landscape orientation, the header and footer 

of the page are also formatted with landscape orientation. Page numbers on landscape-

oriented pages should be in the same position as page numbers on portrait-oriented pages. 

For example, if portrait pages have page numbers centered at the bottom, then the 

landscape pages will also have page numbers centered at the bottom. 

Creating different page number styles in one document  

¶ Use the Section break formatting to have different page numbering styles. A new section is 

created that starts on the next page. With this type of section break, you can apply different 

page numbers, headers, footers, page orientation, paper size, and vertical alignment to the 

sections in the document. If you are using templates, this is already taken care. 

Thesis/ Dissertation should have the following sections: 

Section 1 - No page numbers on Title page, Copyright page, or Approval page. 

Section 2 - The pages after the Approval page and preceding the text, i.e. Abstract, 

Acknowledgements, Table of Contents etc. should be numbered using lower case Roman 

numerals (i, ii, iii ..) starting with Abstract. 

Section 3 - Text pages, References/Bibliography, Appendices and Vita should consist of 

Arabic numerals (1, 2, 3é) 

By default, word document comes with Section 1. So, creating Section breaks 2,3 should 

serve the purpose.  

For creating Section 2  

¶ Click at the end of Approval page. 

¶ Click Layout tabĄ Breaks then under Section Breaks, click Next Page. So, this 

creates a new section 2 from Abstract. 
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¶ Click on the header/ footer of Abstract page (Section 2) and click Link to Previous button 

to disable it. This unlinks Section 2 from Section 1 and allows user to create roman page 

numbers in Section 2 without creating page numbers in section1.  

 

For creating Section 3 
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¶ Click at the end of page with last roman page number. 

¶ Click Layout tabĄ Breaks then under Section Breaks, click Next Page. So, this 

creates a new section 3 from Chapter 1 (text). 

¶ Click on the header/ footer of Chapter 1 (Section 3) and click Link to Previous button to 

disable it. This unlinks Section 3 from Section 2 and allows to create Arabic page 

numbers in Section 3 without messing up with roman numbers in section 2. 

Note: Donôt forget to unlink header and footer of each section from its previous section. By 

default, the Link to Previous button is enabled. You can see it dark grey if it is enabled.  

Inserting roman page numbers for front pages  

¶ Double click on the footer section of the Abstract page (Section 2). It automatically opens 

the Design tab.  

¶ Click Page number Ą Bottom of the page and choose center alignment (Plain Number 2).  

 

¶ It assigns Arabic page numbers 1, 2, 3 ..  

¶ Select page number and change the font style and size to make it consistent with the text.  
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¶ Now right click on the page number and choose Format Page numbers to change the 

format from Arabic to Roman page numbers. 

¶ Choose Roman number format from the drop-down list, start at i and click OK. 

 

Inserting Arabic Page numbers 

¶ Arabic page numbers are located either right-aligned on the top of the page or centered 

on the bottom of the page. 

¶ Follow the same procedure mentioned above in order to insert Arabic page numbers at 

the bottom center. You donôt have to change the number format.  

¶ To have them aligned on the top- right, double click on the header section of the first 

chapter page. 

¶ Click Page number Ą Top of the page and choose right alignment (Plain Number 3).  
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¶ It assigns Arabic page numbers 1, 2, 3 ..  

¶ Select page number and change the font style and size to make it consistent with the text. 

 

Changing the orientation of a particular page(s) to Landscape  

¶ Create a Section break - next page on the previous page for which the orientation has to 

be changed.  

¶ Add another Section break at the end of last landscape page.  

¶ Click the header, to confirm a new section has been created. This allows you to change 

the page layout of only this section without changing the layout of the entire document. 

¶ Click LayoutĄ  Orientation  and set the Orientation to Landscape  
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HEADINGS AND SUBHEADINGS 

¶ Chapter titles ï All chapter titles and top headings should be in all capital letters. 

(including front and back content, e.g., PREFACE, CHAPTER 1, APPENDIX, etc.) 

¶ Either bold all top headings or donôt bold any. 

¶ Use numerals (1,2,3...) instead of words (ONE, TWO, THREE) to represent Chapter 

numbers. E.g. CHAPTER 1 instead of CHAPTER ONE (in the Table of Contents and on 

the heading for the chapter). 

¶ Be consistent with chosen format style for headings and sub-headings throughout your 

document.  

¶ Donôt leave a heading without text underneath it at the very bottom of the page. 

MULTIMEDIA OBJECTS 

Multimedia object types include oversized tables, complex equations, graphs, diagrams, digital 

pictures, digital video, digital audio, virtual reality, and even computer software that you have 

developed. 

¶ Multimedia objects and oversize maps/files may be included as a supplementary file. 

¶ Supplementary files may be uploaded to ProQuest in addition to your ETD pdf file. 

SIMPLE OBJECTS 

Most simple objects like tables, graphs, and diagrams can be embedded in your ETD using your 

Word Processor. Here are some guidelines when you embed the objects. 

¶ Float the object to the top of the page.  

¶ Your page can have multiple objects provided they all completely fit, without 

compromising on margins. 

¶ Title should be directly below the object for figures and above for tables. Number the 

object according to its position in the chapter (e.g., in Chapter 5 you may have a Table 

5.1, Table 5.2, and Figures 5.1, 5.2, and 5.3). 

¶ When tables or figures are too wide to fit within the required one-inch margins, either 

reduce the size (if possible) or change the orientation of that page to landscape. 
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INCLUDING PREVIOUSLY-PUBLISHED CONTENT 

To include content that has been published elsewhere (even if you are the author), you must 

follow certain steps to ensure you avoid copyright infringement. 

¶ Content that is in the PUBLIC DOMAIN does not have copyright issues. This content 

includes only works created and published by the U.S. government and works where the 

author has been deceased for over 70 years. All other published works are covered by 

copyright laws. 

¶ To include previously published content (anywhere in your paper, including in the 

appendix) that is not in the public domain, you must do two things: 1.) Cite the source 

where you found the content under the content wherever you are including it. Use a full 

citation with title, author, date, publisher, URL (if appropriate), etc.   2.) Include the 

permission that you received to include the content in your paper. This permission might 

come in various forms: an email from the publisher, an excerpt from original 

work/website that states that anyone has permission, or (if you were the author) a clause 

from your publishing contract. (see Example 1 below.) 

¶ Examples of content that must have permission include: an entire survey instrument*  that 

someone else wrote and published, a unique and complicated figure that someone else 

designed and published, a poem or song that someone else wrote and published, a 

photograph or image that someone else took/created and published. 

¶ You have more flexibility to use PART OF something without getting permission. For 

example, you could provide the first question of the survey instrument, a couple lines of 

the poem, or you could adapt part of the complicated figure to fit your research (see 

Example 2 below.) If you use only a small part of the content, this is considered FAIR 

USE. You can do this without getting permission, but you still must cite the original 

source. If you adapted the work, state that you adapted it as part of the citation. Also 

include the original source in your list of REFERENCES. 

¶ FAIR USE can also be achieved by using a small version of an image or photograph (as 

opposed to a larger one). Use the smallest size possible that will be acceptable for your 

purposes. Also, it is best to include previously-published content only when it is intricate 

to the message of your paper, when it is the best way to elaborate or support your 

argument. Always cite the original source of an image or photograph. 

¶ Many publishers have forms to request permission on their websites. If there is no form, 

an email is also an acceptable method of requesting permission. Be sure to tell them that 

you want to include the content in your thesis or dissertation. They almost always say yes 

to this type of use. 

 

* Note the difference between being able to use a survey instrument to gather data for your 

research study AND being able to include that entire survey instrument in your appendix! 

These two actions require different and separate permissions. 

Ask Dr. Rose Moroz if you have questions about including previously-published content. See 

below for examples. 
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Example 1  

This example shows where a student included a previously-published figure, properly cited its 

source, found permission on the publisherôs website, and included the permission in the 

appendix. 
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Example 2  

This example shows where a student included just a small part of a previously-published attitude 

scale (in order to avoid needing publisher permission) and properly cited the source where the 

entire attitude scale could be found. 

 

 

 

APPENDIX 

¶ List of terms, definitions, questionnaires, and other supplemental information which is 

useful, but not essential, to the body of the thesis or dissertation may be included in an 

appendix. 

¶ When you have more than one appendix, name each Appendix with a letter (A, B, C, 

etc.) and list each Appendix separately with a title in the Table of Contents. 

¶ An APPENDICES cover page prior to Appendix A in your paper is optional. 

¶ Because these final papers will be available online, you must remove all signatures from 

any documents that you include in your paper. 

¶ Any previously-published content that you include in your appendix must be properly 

cited and permission displayed as appropriate. (See the previous section of this 

document.) 
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VITA  

¶ Only mention the degrees you have already earned, not the degree in progress.  

¶ Only list publications that were already published or accepted, not the ones in process.  

¶ If a publication has been accepted for publication but not yet published, note it with (in 

press). 

Submission Guidelines 

After you pass your defense... 

¶ Your committee members will sign the Thesis/Dissertation Approval and Oral Defense 

forms, and your department representative will submit one original of each of these forms 

to the Graduate School. 

¶ It is requested that the Thesis/Dissertation Approval forms be printed on 25% bond paper 

to match the paper used in the Morris Library copy. This official form is bound into the 

Morris Library copy of your paper. 

 

SOME ITEMS TO HAVE HANDY WHEN YOU LOGIN TO SUBMIT YOUR ETD 

¶ A PDF copy of your dissertation/thesis. This must be a single file.  

¶ Abstract 

¶ Optional Supplementary files (images, data, etc.) that are an integral part of the 

dissertation/thesis, but not part of the full text.  

¶ Advisor and other Committee Members' names 

¶ Three subject categories that best include your dissertation/thesis. 

¶ A credit card to make the payment.  

SUBMISSION PROCESS FOR THESIS/DISSERTATION 

Allow about 30-60 minutes to submit your paper for the first time. There are several steps to the 

process and questions to answer. 

¶ Login to ProQuest Submission site. 

¶    Fill out the form according to the instructions provided  

¶    Preview and make certain all information is correct 

¶ Respond to questions about type of publishing, copyright registration, delay of 

publication (ñembargoò), and ordering bound copies. (See below for more details about 

these questions.) 

¶ Pay submission fee(s) using credit card (minimum fee required $30; other fees for 

optional services. 

¶    Browse and submit your ETD 

¶ Submit any associated supplementary multimedia files (optional) 

¶    Select "Submit" to submit to the Graduate School 

¶ You will see a web page indicating that your ETD arrived and awaits review 

 

IMPORTANT DETAILS ABOUT THE SUBMISSION PROCESS 

¶ Submit complete paper by initial deadline. 

¶ Any day before the initial deadline is okay for submission, The sooner the better! 

https://www.etdadmin.com/cgi-bin/school?siteId=48
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¶ After you submit, please allow us a couple of days to get back to you.  

¶ Be patient because others are also submitting. Sometimes 50 or more students submit in 

one day! 

¶ Come to see us during our walk-in hours or anytime by an appointment. 

¶ For any queries, call us at 618-453-8501, 618-453-4514 or send an email to 

ETDsupport@siu.edu  

After your paper has been approved, hereôs the email message that you will receive: 

 

¶ Once approved, you donôt have to submit your paper again. The final, approved 

submission is used as the final version.  

¶ After your paper is approved, your file is sent to the Graduate School Graduation Office 

for graduation clearance.  

¶ The Graduation office will NOT send you any message if /when you have been cleared 

for graduation. Instead, your department will be notified only if there is a problem.  

FEES 

¶ There is a $30 one-time fee to cover the cost of a hardbound copy for the SIUC Morris 

Library. This is the only fee required for submitting your Thesis/Dissertation. 

¶ You donôt have to pay for the resubmissions. 

¶ Choose Traditional Publishing and ProQuest will upload your paper to OpenSIUC. There 

is no publishing fee for Traditional Publishing.  

¶ ProQuest would charge an additional $95.00 fee for making your work openly accessible, 

but you can get the same service (Open Access) free of cost through OpenSIUC by 

replying to the OpenSIUC email that you will receive 4-6 weeks after graduation. For 

more information, visit https://opensiuc.lib.siu.edu/ or email opensiuc@lib.siu.edu  

¶ As author of your thesis/dissertation, you own the copyright, but you have the option to 

request that ProQuest register your copyright on your behalf. If you choose this option, an 

additional copyright fee of $75.00 will be added to your submission costs. For more 

information about copyright and your thesis/dissertation, select the ñResources & 

Guidelinesò tab in ProQuest. 

 

OPEN ACCESS AND OPENSIUC INFORMATION 

¶ When submitting to ProQuest, you will be asked to select a type of publishing. Choose 

ñTraditional Publishing.ò If you would like to make your thesis/dissertation available via 

mailto:ETDsupport@siu.edu
https://opensiuc.lib.siu.edu/
mailto:opensiuc@lib.siu.edu
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open access, then you can do this for no charge through OpenSIUC. There is a $95 

charge for this service through ProQuest, but there is no need to pay this fee!  

¶ After your thesis/dissertation has been approved and your date of graduation has passed, 

the Graduate School will forward your ETD to ProQuest, and then ProQuest will forward 

your ETD to OpenSIUC. OpenSIUC will post your ETD so that anyone on the SIU 

campus may access your thesis/dissertation, unless you have requested an embargo. 

¶ OpenSIUC will send you an email asking if you want to make your thesis/dissertation 

Open Access, which would make it available to anyone anywhere via the internet. If you 

do want this, then respond to the email to allow this to happen. Then your 

thesis/dissertation will be available to everyone within SIUC and beyond. OpenSIUC will 

make this happen without charge, but only if you give your permission. 

¶ If you do not respond to the OpenSIUC email, then your thesis/dissertation will only be 

available in three ways: 1) a printed copy in the Special Collections section in Morris 

Library 2) through OpenSIUC (on campus) and 3) via ProQuest either by direct purchase 

or via access to the ProQuest Dissertations and Theses database, unless you request an 

embargo. 

¶ If you canôt find the email from OpenSIUC, and you want your thesis/dissertation to be 

available through Open Access, then you can contact OpenSIUC at opensiuc@lib.siu.edu 

and make this request. 

¶ More information about OpenSIUC is available at http://opensiuc.lib.siu.edu/faq.html . 

EMBARGO  

¶ ProQuest will ask if you want them to release your work (make it available on their website 

and to search engines) right away or to delay release.  

¶ The soonest that your work will be released is about 5 weeks after the day of graduation. 

You can choose to release your work after any length of time or even never release it. 

¶ If you choose to delay the release of your work, access to the full text of your work will be 

delayed for the period of time that you specify using this option.  

¶ Choose ñNoò to delay the release of your work, and then choose the length of the delay 

and the reason for the delay. See below. 

 

mailto:opensiuc@lib.siu.edu
http://opensiuc.lib.siu.edu/faq.html
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¶ To delay more than 2 years, write a note to the administrator. Tell exactly how long you 

would like to delay. Then choose a reason for delay from the drop-down. 

¶ If you arrange an embargo and later want to shorten or lengthen the embargo time period, 

contact both ProQuest (800-521-0600) and OpenSIUC to request the change. 

 

COPYRIGHT REGISTRATION 

As author of your thesis or dissertation, you own the copyright, but ProQuest will offer to 

register your copyright with the U.S. Office of Copyright for $75. 

¶ Registering with the U.S. Office of Copyright establishes your claim to the copyright for 

your dissertation/thesis and provides certain protections if your copyright is violated. 

¶ More Information: http://www.copyright.gov/help/faq/mandatory_deposit.html  

¶ This is optional. Consult with your advisor if you are unsure about whether or not to do 

this. 

 

 

 
 

ORDERING COPIES  

¶ Ordering bound copies through ProQuest is optional. It costs around $62.00 and takes 

about 8-12 weeks after the graduation date to be mailed. 

¶ Another option is for you to print your approved paper and take it to the SIU University 

Bookstore in the Student Center. They will arrange for it to be professionally bound for 

just $30.00 in 4 weeks or less after your paper is approved. Contact the Bookstore at 618-

536-3321 for more information. SUSPENDED DUE TO COVID-19 CLOSED 

CAMPUS! 

 

OTHER COMPLETION INFORMATION 

 

SURVEY OF EARNED DOCTORATES 

¶ If you are a doctoral student, you must complete the Survey of Earned Doctorates 

available at https://sed-ncses.org/login.aspx before the final submission deadline. After 

you complete this survey, a Survey of Earned Doctorates completion certificate will be e-

mailed to you and to the Graduate School.   

http://www.copyright.gov/help/faq/mandatory_deposit.html
https://sed-ncses.org/login.aspx
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FORMS 

¶ All Thesis/ Dissertation Oral Defense and Approval forms are available on 

https://gradschool.siu.edu/about-us/forms.php. These forms are to be completed, signed, 

and submitted by your advisor or program administrator or staff. Forms submitted by 

students will not be accepted. 

¶ The Graduate School would need one Oral Defense and one Approval form by the Final 

Submission Deadline in order to accept your paper.  

¶ Thesis/Dissertation Approval forms are archived with the paper in Morris Library. 

¶ Signatures on the forms must be valid. 

¶ The instructions for digitally signing forms are available at 
https://gradschool.siu.edu/about-us/forms.php 

¶ Email IRB compliance forms to Dr. Rose Moroz, Assistant Dean of the Graduate School 

at rmtmoroz@siu.edu if your paper involves human subjects or use of live vertebrate 

animals.  

 

LETTER OF COMPLETION 

If you need to have official university confirmation that you have completed your degree, prior 

to graduation day, then you may send an email with your dawg tag to grad.graduation@siu.edu 

to request a Letter of Completion. This letter cannot be written until after you are completely 

cleared for graduation. 

 

OTHER NOTES 

¶ If you were required to secure permission for using human subjects or animals in your 

study, then you must submit a copy of your approval letter to the Graduate School. Send 

it attached to an email addressed to rmtmoroz@siu.edu. It is recommended that you make 

a statement within your methods section that the study methods have been approved by 

the SIUC Human Subjects Committee or SIUC Institutional Animal Care and Use 

Committee. You are not required to include this approval letter in your paper. If you do 

include it in your appendix, be sure to white out any signatures.  

¶ If you include equations in your paper, and you number them, place the equation numbers 

in a straight vertical line at the right margin. Be consistent with your numbering system. 

¶ Make sure you donôt have any INC or DEF grades on your transcript (other than 599 or 

600). You must complete all incomplete courses before graduation. 

¶ Diplomas are mailed after graduation. Please allow up to 8 weeks after graduation to 

receive your diploma. You can arrange to pick up your diploma at the Graduate School if 

you prefer by sending an email to grad.graduation@siu.edu.  

¶ If you have questions about graduation applications or procedures, contact 

grad.graduation@siu.edu. 

¶ If you have questions about the commencement ceremony, visit 
https://commencement.siu.edu/ 

¶ If you have questions about the ProQuest website or ordering through ProQuest, contact 

their Customer Service at 800-521-0600 extension #77044. 

¶ Questions or feedback regarding this Guidelines document should be directed to Dr. Rose 

Moroz, Assistant Dean of the Graduate School, rmtmoroz@siu.edu. Revised 10/4/20 

https://gradschool.siu.edu/about-us/forms.php
https://gradschool.siu.edu/about-us/forms.php
mailto:rmtmoroz@siu.edu
mailto:grad.graduation@siu.edu
mailto:rmtmoroz@siu.edu
mailto:grad.graduation@siu.edu
mailto:grad.graduation@siu.edu
https://commencement.siu.edu/
mailto:rmtmoroz@siu.edu
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PART I I  ï RESEARCH PAPER GUIDELINES  
 

ORGANIZATION OF PAGES  

(See Research Paper Template) 

The pages of your paper should be in the following order: 

1. Title page 

2. Copyright statement (when applicable) 

3. Approval page 

4. Abstract 

5. Dedication (Optional) 

6. Acknowledgments (Optional) 

7. Preface (Optional) 

8. Table of Contents 

9. List of Tables (with page references ï required if you have more than one table) 

10. List of Figures (with page references ï required if you have more than one figure) 

11. Text/Body 

12. Exhibits (tables, figures, photographs, etc. ï required if you are presenting all of your 

tables and figures after the body of your paper) 

13. References (or other appropriate title prescribed by your programôs style manual) 

14. Appendices (Optional ï required if you have copyright permission or other documents 

that do not fit elsewhere in your paper) 

15. Vita  

TITLE PAGE 

¶ Make sure that your paper title on the title page, the approval page, the abstract page, the 

vita page, your Oral Defense and Research paper Approval forms match exactly. 

¶ Month Year at the bottom of this page is the month and year of graduation. 

APPROVAL PAGE 

¶ Only the names (not the signatures) of your committee are needed for this page. (The 

signatures will be on the original paper Research Paper Approval form that is submitted 

to the Graduate School.) 

¶ Date on this page is the date on which your committee signs your approval form. It 

should be in the format Month Date, Year, for example, March 8, 2019. 

 

https://gradschool.siu.edu/current-students/thesis-dissertation-researchpaper/research-paper-guidelines.php
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ABSTRACT 

¶ Date on this page is the date of your defense in the format Month Date, Year. 

TABLE OF CONTENTS 

¶ Do not list the Table of Contents as an entry on the Table of Contents page. 

¶ Put the ones digit of every page number in a straight vertical line at the right margin. 

¶ Include the titles of Chapters and Appendices. 

¶ Where chapter titles are longer than one line, end the first line before it reaches the page 

number vertical line, and then indent the first word of the second line so that it starts 

under the first word of the first line. (See templates.) 

¶ Indent the chapter listings under the word CHAPTERS, and indent the appendices 

listings under the word APPENDICES. 

¶ Table of Contents are already created on the templates, and you only need to customize 

this page. Another option is to create an active Table of Contents by following the 

instructions below. 

Inserting a table of contents using the inbuilt option from MS Word 

¶ In Word, tables of contents rely on your use of styles to format headings. If you already 

used the Heading 1, Heading 2, and other heading styles to format your document, youôre 

ready to insert your Table of Contents. Follow these steps to insert a Table of Contents: 

o Click where you want to create the table of contents and click the References tab.  

o In the Table of Contents group, click Table of Contents. 

 
o Choose the style of Table of Contents you wish to insert. Automatic Table 1 

creates a Table of Contents titled Contents. Automatic Table 2 creates a Table of 

Contents titled Table of Contents. So, Automatic Table 2 is recommended.  

o Manually add the sub titles CHAPTER and PAGE and align them utmost right 

and left respectively. 

o Word will create a Table of Contents from the document text you styled with one 

of the first three heading styles: Heading 1, Heading 2, and Heading 3. The Table 
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of Contents will include a string of dots between the heading text and the page 

number for each heading. 

o When readers hover over a page number, the headings are highlighted which 

reminds that they can use the Table of Contents for navigation. 

¶ After the headings are inserted, change the font style of the title TABLE OF 

CONTENTS, center align it, make it all capitals and also set the font color to Black.  

¶ Set the line spacing to 2.0, change the font style, size of the headings, page numbers (if 

needed) to make it consistent with the rest of the document.  

Updating Table of Contents 

After youôve edited your document, page numbers and headings may change, which will make 

your Table of Contents incorrect!  

¶ To update your Table of Contents, right-click in the table and choose Update Field 

or 

¶ choose Update Table from the Table of Contents group on the References tab. Select 

entire table or page numbers only and click OK to regenerate the table of contents from 

your headings. 

 

No Heading styles? 

¶ If the headings in your document arenôt formatted with styles, before inserting your table 

of contents, select each of the top-level headings for your Table of Contents and apply the 

Heading style from the Styles group on the Home tab of the ribbon. 

 

or 

¶ Follow the templates and manually type in the headings to create a Table of Contents. 

 



29 
 

LIST OF TABLES and LIST OF FIGURES 

¶ Put the ones digit of every page number in a straight vertical line at the right margin. 

¶ It is required to include table/figure title next to table/figure number. 

¶ Where table/ figure titles are longer than one line, end the first line before it reaches the 

page number vertical line, and then indent the first word of the second line so that it starts 

under the first word of the first line. 

For exampleé 

Figure 23. The effect of switch cost on the total annual cost and the optimum number of  

                  switches....................................................................................................................... 65 

 

Formatting Guidelines 

FONTS 

¶ Use the same font throughout your paper. Some standard fonts to choose from: Times 

New Roman, Bookman, Courier, or Ariel. 

¶ The regular text in the body of the document should use a 10 or 12 point font size. 

Headings and subheadings may go up to 14 point but must be of the same font style as 

the body of the text. 

¶ Bold and Italics may be used. In general, italics is used for Genera, species, letters, 

words or phrases cited as a linguistic example, and foreign words. Bold and italics may 

be used to distinguish heading and sub-heading levels; follow your department 

guidelines, and be consistent throughout your paper. 

¶ For tables, six (6) point font should be the smallest used. Try to use the same size as the 

rest of the body, if possible. 

SPACING 

¶ The body of the document must be double spaced.  

¶ There should be no extra spacing between paragraphs. 

¶ There should be no extra spacing before and after each sub-heading. 

¶ Spacing within the table may be single or double spaced based on the readability of the 

data. 

¶ There should be a judicious use of spacing to "set off" tables, charts, and figures; 

typically, one double space before and after the table. Again, once spacing is chosen, you 

must be consistent throughout. 

¶ Places where single spacing is acceptable: 

¶ Between the lines of a title or heading that takes up more than one line. 

¶ Between the lines of a long quote that is indented on both sides. 

¶ Within a figure or table. 

¶ Between the lines of a figure/table title or explanation/description  

¶ Within a reference in the References section. If you single space between the multiple 

lines of a reference, then you should insert a blank space between reference entries. 



30 
 

¶ Within footnotes. 

Double spacing the document 

¶ Navigate to Design tab. 

¶ Go to Paragraph Spacing (on Top Right) and Set that to Double. 

 
or 

¶ Select the paragraph which needs to be double spaced. 

¶ Navigate to Home ĄParagraph line spacing options Ą2.0 

Deleting extra space above each sub heading, paragraphs.  

Only 2.0-line space is allowed throughout your work. Sometimes, though the line spacing is set 

to double, you still can see some extra space between the lines, especially above each sub 

heading, new paragraph etc.  

To fix this: 

¶ Select text.  

¶ On Home tab Ą Paragraph Ą Click paragraph Settings button on the bottom right. 
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¶ On Indents and Spacing tab set the Spacing to 0 for both Before and After tabs. 

¶ Click OK. 



32 
 

 

TEXT JUSTIFICATION 

¶ The text in chapters should be left justified only, unless your program requires full 

justification of text (e.g., Mathematics). 

¶ Text on title page and approval page are centered. 

¶ Chapter titles are centered, and other headings may be centered, as fits your program- 

designated style. 

MARGINS AND INDENTATIONS 

¶ Margins are one inch all around. So, text should start one inch below the top of the page 

and end one inch above the bottom of the page.  

¶ Pages with charts, tables, and figures may have greater margins than listed but may not go 

into the required margins. 

¶ Paragraph indentations should be a uniform five spaces.  

¶ With a heading at the bottom of a page, when there is not room for at least one line of 

text under it, move the heading to the next page. In this situation, it is acceptable to have 

a larger bottom margin. 

PAGINATION 

¶ No page numbers on Title page, Copyright page, or Approval page. 

¶ The pages after the Approval page and preceding the text, i.e. Abstract,  
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Table of Contents etc. should be numbered using lower case Roman numerals (i, ii, iii, ..) 

starting with Abstract.  

¶ Roman numeral page numbers must be centered and positioned one-half inch from the 

bottom of the page. 

¶ Text pages, References/Bibliography, Appendices and Vita should consist of Arabic 

numerals (1, 2, 3..) only, without punctuation, embellishment, or running headers. This 

numeral paging should be continuous. 

¶ For Research Papers, the Arabic page numbers should be located right-aligned on the top 

of the page.  

¶ Page numbers need to be consistent with the same font style and size as the regular text. 

¶ If a page of your document is formatted with landscape orientation, the header and footer 

of the page are also formatted with landscape orientation. Page numbers on landscape-

oriented pages should be in the same position as page numbers on portrait-oriented pages. 

For example, if portrait pages have page numbers on the top right, then the landscape pages 

will also have page numbers on the top right corner. 

Creating different page number styles in one document  

¶ Use the Section break formatting to have different page numbering styles. A new section is 

created that starts on the next page. With this type of section break, you can apply different 

page numbers, headers, footers, page orientation, paper size, and vertical alignment to the 

sections in the document. If you are using templates, this is already taken care. 

Research paper should have the following sections: 

Section 1 - No page numbers on Title page, Copyright page, or Approval page. 

Section 2 - The pages after the Approval page and preceding the text, i.e. Abstract, 

Acknowledgements, Table of Contents etc. should be numbered using lower case Roman 

numerals (i, ii, iii ..) starting with Abstract. 

Section 3 - Text pages, References/Bibliography, Appendices and Vita should consist of 

Arabic numerals (1, 2, 3..) 

By default, word document comes with Section 1. So, creating Section breaks 2,3 should 

serve the purpose.  

For creating Section 2  

¶ Click at the end of Approval page. 

¶ Click Layout tabĄ Breaks then under Section Breaks, click Next Page. So, this 

creates a new section 2 from Abstract. 
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¶ Click on the header/ footer of Abstract page (Section 2) and click Link to Previous button 

to disable it. This unlinks Section 2 from Section 1 and allows user to create roman page 

numbers in Section 2 without creating page numbers in section1.  
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For creating Section 3 

¶ Click at the end of page with last roman page number. 

¶ Click Layout tabĄ Breaks then under Section Breaks, click Next Page. So, this 

creates a new section 3 from Chapter 1 (text). 

¶ Click on the header/ footer of Chapter 1 (Section 3) and click Link to Previous button to 

disable it. This unlinks Section 3 from Section 2 and allows to create Arabic page 

numbers in Section 3 without messing up with roman numbers in section 2. 

Note: Donôt forget to unlink header and footer of each section from its previous section. By 

default, the Link to Previous button is enabled. You can see it dark grey if it is enabled.  

Inserting roman page numbers for front pages  

¶ Double click on the footer section of the Abstract page (Section 2). It automatically opens 

the Design tab.  

¶ Click Page number Ą Bottom of the page and choose center alignment (Plain Number 2).  

 

¶ It assigns Arabic page numbers 1, 2, 3 ..  

¶ Select page number and change the font style and size to make it consistent with the text.  



36 
 

 
¶ Now right click on the page number and choose Format Page numbers to change the 

format from Arabic to Roman page numbers. 

¶ Choose Roman number format from the drop-down list, start at i and click OK. 

 

Inserting Arabic Page numbers 

¶ Arabic page numbers are located right-aligned on the top of the page  

¶ To have them aligned on the top- right, double click on the header section of the first 

chapter page. 

¶ Click Page number Ą Top of the page and choose right alignment (Plain Number 3).  
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¶ It assigns Arabic page numbers 1, 2, 3 ..  

¶ Select page number and change the font style and size to make it consistent with the text. 

 

Changing the orientation of a particular page(s) to Landscape  

¶ Create a Section break - next page on the previous page for which the orientation has to 

be changed.  

¶ Add another Section break at the end of last landscape page.  

¶ Click the header, to confirm a new section has been created. This allows you to change 

the page layout of only this section without changing the layout of the entire document. 

¶ Click LayoutĄ  Orientation  and set the Orientation to Landscape  
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HEADINGS AND SUBHEADINGS 

¶ Chapter titles ï All chapter titles and top headings should be in all capital letters. 

(including front and back content, e.g., PREFACE, CHAPTER 1, APPENDIX, etc.) 

¶ Either bold all top headings or donôt bold any. 

¶ Use numerals (1,2,3...) instead of words (ONE, TWO, THREE) to represent Chapter 

numbers. E.g. CHAPTER 1 instead of CHAPTER ONE (in the Table of Contents and on 

the heading for the chapter). 

¶ Be consistent with chosen format style for headings and sub-headings throughout your 

document.  

¶ Donôt leave a heading without text underneath it at the very bottom of the page. 

MULTIMEDIA OBJECTS 

Multimedia object types include oversized tables, complex equations, graphs, diagrams, digital 

pictures, digital video, digital audio, virtual reality, and even computer software that you have 

developed. 

¶ Multimedia objects and oversize maps/files may be included as an Additional file. 

SIMPLE OBJECTS 

Most simple objects like tables, graphs, and diagrams can be embedded in your paper using your 

Word Processor. Here are some guidelines when you embed the objects. 

¶ Float the object to the top of the page.  

¶ Your page can have multiple objects provided they all completely fit, without 

compromising on margins. 

¶ Title should be directly below the object for figures and above for tables. Number the 

object according to its position in the chapter (e.g., in Chapter 5 you may have a Table 

5.1, Table 5.2, and Figures 5.1, 5.2, and 5.3). 

¶ When tables or figures are too wide to fit within the required one-inch margins, either 

reduce the size (if possible) or change the orientation of that page to landscape. 
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APPENDIX 

¶ List of terms, definitions, questionnaires, and other supplemental information which is 

useful, but not essential, to the body of the research paper may be included in an 

appendix. 

¶ When you have more than one appendix, name each Appendix with a letter (A, B, C, 

etc.) and list each Appendix separately with a title in the Table of Contents. 

¶ An APPENDICES cover page prior to Appendix A in your paper is optional. 

¶ Because these final papers will be available online, you must remove all signatures from 

any documents that you include in your paper. 

VITA  

¶ Only mention the degrees you have already earned, not the degree in progress.  

¶ Only list publications that were already published or accepted, not the ones in process. If 

a publication has been accepted but not yet published, note it with (in press). 

 

Submission Guidelines 

After you pass your defense... 

¶ Your committee members will sign the Research Paper Approval and Oral Defense 

forms, and you or your department representative will submit one original of each of 

these forms to the Graduate School. 

BEFORE YOU BEGIN THE SUBMISSION PROCESS, PLEASE MAKE SURE YOU HAVE THE 

FOLLOWING ITEMS: 

¶ The submission's title 

¶ An abstract of 250 words or less (optional)  

¶ A list of keywords (10 maximum) (optional) 

¶ Full name of your Advisor 

¶ Your document in Word format (preferred) or pdf 

¶ Additional files, if any. 

SUBMISSION PROCESS FOR RESEARCH PAPER 

¶ Navigate to OpenSIUC submission site. 

¶    You will need an account to make your submission. To do so, click on the ñMy Accountò 

link in the upper right of the screen. 

 

https://opensiuc.lib.siu.edu/gs_rp/author_guidelines.html
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¶    Login to your account. 

¶ Click on the "Submit Research" link in the lower left of the screen. 

     
¶ Fill in all the details, browse and upload your Research Paper.   

¶ Submit any associated supplementary multimedia files (optional). 

¶    When the preceding steps are complete, click on the ñSubmitò button at the bottom of the  

 screen. This completes the submission process.  

 

IMPORTANT DETAILS ABOUT THE SUBMISSION PROCESS 

¶ Submit complete paper by initial deadline. 

¶ Any day before the initial deadline is okay for submission, The sooner the better! 

¶ After you submit, please allow us a couple of days to get back to you.  

¶ Be patient because others are also submitting. 

 

After your paper has been approved, hereôs the email message that you will receive: 
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¶ Once approved, you donôt have to submit your paper again. The final submission is used 

as the final version.  

¶ After your paper is approved, your file is sent to the Graduate School Graduation Office 

for graduation clearance.  

¶ The Graduation office will NOT send you any message if you have cleared for 

graduation. Instead, your department will be notified only if there is a problem.  

FEES 

¶ There is not a fee for Research Paper submission. 

 

COPYRIGHT 

 

Copyright Permission for Use of Published Work 

¶ To use an already published work (text, photograph, drawing, data etc.) in your paper, 

you must obtain permission from the publisher of that work. 

¶ Most publishers have forms to request permission on their websites. If there is no form, 

an email is also an acceptable method of requesting permission.  

¶ Cite the source in your paper at the point of use, and insert the permission letter/email in 

the Appendix.  

 

Forms 

¶ The Research Paper Oral Defense and Approval forms are available on 

https://gradschool.siu.edu/about-us/forms.php  

¶ Create 2 originals for each, just to be safe. Only 1 original of each must be submitted to 

the Graduate School. 

¶ The Graduate School would need one Oral Defense and one Approval form before the 

Final Submission Deadline in order to accept your paper. Either you or your program 

representative will submit one original of each of these forms to the Graduate School. 

¶ The Signatures must be original ï no fax, scans, stamps, or color printed. 

¶ Committee members who are away from campus and cannot sign the forms by hand may 

e-sign them. The instructions for getting the e-signatures are available on  

https://gradschool.siu.edu/_common/documents/forms/instructions-for-e-signing.pdf  

¶ Print the e-signed forms and get the signatures from other faculty members by hand on 

those same papers. 

 

https://gradschool.siu.edu/about-us/forms.php
https://gradschool.siu.edu/_common/documents/forms/instructions-for-e-signing.pdf
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LETTER OF COMPLETION 

If you need to have official university confirmation that you have completed your degree, prior 

to graduation day, then you may send an email with your dawg tag to grad.graduation@siu.edu 

to request a Letter of Completion. This letter cannot be written until after you are completely 

cleared for graduation. 

 

Questions about formatting a Research Paper should be directed to Mr. John Russell at 

johnprussell@siu.edu.  

 

Questions or feedback regarding this Guidelines document should be directed to Dr. Rose 

Moroz, Assistant Dean of the Graduate School, rmtmoroz@siu.edu.  

 

Revised October 4, 2020 

 

 

mailto:grad.graduation@siu.edu
mailto:johnprussell@siu.edu
mailto:rmtmoroz@siu.edu

